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Abstract

This thesis is a study of the effects of different process parameters in producing Al-5Ti-1B grain
refiner, i.e. various sequences and reaction time, on grain refinement efficiency of aluminum
castings. It was found that different process parameters resulted in different morphology and
size distribution of TiAl; and TiB, in grain refiner. The experiment was carried out by adding KBF,
and K, TiF, into molten aluminium. The melting temperature was controlled at 800 °C in an electric
resistance furnace. Three different sequences of KBF, and K,TiF, additions were applied to this
study, i.e., adding KBF, before K,TiF, adding K,TiF, before KBF, and mixing both KBF, and
K,TiF before adding into molten aluminum. Three different holding times at 1 minute, 30 minutes
and 60 minutes were applied. The results showed that no significant difference of morphology and
size distribution was found from the experiment of varying three different sequences. Whereas,
the different holding time provided major differences in both the morphology and the size
distribution, which are technically expectable from diffusivity and contractibility between particles
resulting in larger particle size and wider range of size distribution of TiAl, and TiB,. For grain
refinement efficiency, it was found that mixing KBF, and K,TiF, before adding into molten

aluminum with a holding time of 30 minutes resulted in best grain refinement efficiency.

Keywords: Grain Refinement / Process Parameters / TiAl, / TiB, / K,TiF, / KBF,
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Qy 1 v o Jdo o a a = {
VNANTUYRIFUNUIINMIHADNANUFUHUTIUIIWIUM SN uAdea Ty TanzaoNraIn
a & 3 o Aa A o A
matulurazude@da (Solidification) lunsdindundsaiiduoyniauanlaousmihngu
a = A A 1 . Y a d? I o o IS o I
HANABANTDNITNIN Heterogeneous Nucleation A UNAVUITUTIUIULINNIBHAINITHAIA N1

Y Lﬂy AN Ya = A = 19 A = A a dy I a A o zﬂy A
waliiile Tavzh Idlazivunamsuiiaziven uandundeaineduilusia@eriuiio Taneh
= 1 . A ¥ [ <Y = A [
i38n71 Homogeneous Nucleation tn3ufl lanienasmsudedagdivua lvgniomnsureny ua

) A a d? = [ @ Ju @ < v Y =S ~ & Y o
Tagi 9 11 vineveunsuiinatiuszlinnuduiusnudasimadudiarednnsdiviiaddas

<3 v A 9 = A =} 19 o < ) = ) Y A F2
msuanTvmamsui laszlivunanazideauanisasimsiouaideziinailiingun 14
o I = [ A = Y1 A 1 o AAa o o A
menasmsgudtvnalvauazney (8] 3UH 2.6n szmiuldiudemwasnunmdudaiion
quazdawalitiuadoa lulinnuansadlondy (Wet ability) voseymazuaumsinanan’la

& 3 U [ A 9 a = A ] 1 Aa a = ~ =
"“]N!‘ﬂuﬂ”IWﬁ\‘N']ULﬂJ@‘LlGU’E]\Tﬂ”IiLﬂﬂNﬁﬂ‘ﬂlllllﬁlﬂgﬁlmﬂﬂ?ilﬂﬂuﬁmﬁﬂﬁjﬂﬂ{luzﬂﬂ 2.6 A



13

[ 1 a [ (% 1 1 o Ya a a' 9 a
‘WaﬂﬂTL!iZ’Vi’JNN’J’ﬁiJWﬁ'ﬂTLlﬂﬁN’(?f\‘lNaﬁﬂﬂWiﬂTiﬁu%Lﬂaﬂﬁlﬂﬂﬂwﬁﬂlﬂﬂﬂigﬂiﬂlihﬁuﬂ1ﬂﬂﬂ
= 9 ] (Y 1 d' o 1=} [ d' d'dl [ 1 a Y7 d‘
waﬂ"lﬂmqmmmm“lmwmzammmmmmmu Glugﬂ‘n 2,691 NUATNAINUTEHINNITUNTN
o o3| o 9Ya = ~ a A g a = P o =R £
ATUIN uJuwa‘nﬂwmmaaﬁawmimﬂsmmmmaumﬂmmmumimﬂwaﬂ”lmwuazmmm
~ 1 I A 9 a = a ~ a ~ ~ a 42’
ummmmzamaﬂmﬂumgmmimummmimﬂwaﬂmmmmaaﬁ NTIEUANRITNISINAVY

Y
T ldwdenulumsadwindosinldms Tnvoswanduly1ddevu [8]

Mucleant Mucieant

Hucleant

a =

517 2.6 WausTHAINAdNATURITIRAsAR U YMIAMTINAKAN [8]

UG

'
v A

) UANAINUIEHINAIFUATNGY ) TANaIusznIrIdudalunang

) HANAINUIZHIFAIFURaRG1N
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2.5.2 Peritectic Hulk Theory
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2.5.3 Hypernucleation Theory
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2.5.4 Duplex Nucleation Theory
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ﬂ?ilﬂﬂ‘l];]ﬂiﬂTﬂuéUﬂﬂ TQUIUIY llWVI']!LlfJiJ ngi‘lﬁ’ﬂu HU ﬁ'nﬂiﬂLﬂﬂslluulﬂ%Wﬂﬂ"liﬁﬂHﬁlﬂ\i
H.Y. Wang tasaue [22] nagou 1AgnANA Differential Thermal Analysis (DTA) UM ITHANHA
= o 1 = 1 < 1 1
sllﬁ)\‘]hl‘ﬂﬂuuﬂw LLﬁZW\?I‘Ui’Bu Iﬂﬂﬁﬂﬁ")uﬂl@QﬂWLMﬂNﬁ’ﬂI‘Uﬁ@ULﬂu 1992 aﬂumuwﬁmmm
a A [ [ - o oy = aAA A 1 VoA
2YQNIUYN AU 50 Lﬂﬂﬁlﬁﬁu@]IﬂﬂuWﬁuﬂ ANHIPUNHUNINADUNINANC) Gluaz*u*uwum N
a o a aaa . . {o <3
31N GEIRY 636 C Lﬂﬂﬂgﬂiﬂ"lﬂ"l'iﬂTfJﬂ'ﬂiJ%}@u (Exothermic reaction) ﬂlﬂ!%ﬁﬂﬁlﬂuﬂl@ﬂ!ﬂlﬂﬂlﬂﬂ
a [ 1] { a o a Aaaa
pzgiiflounuluseunaraueynia AIB, Nguugi 660 °C AalgnseIMsganusou
. . A a A o ~ A o 2 A
(Endothermic reaction) WBINANTIUABNULHAIVOIDTQUIHIN NYUNHY 852 C GULl”l‘lJLllﬂvnﬂTi
. v y A a o Y 998 o . < I a ¢
HWal Al-Ti-B Sl,Wﬂ'J"Illi@LWIQﬂ!W{]ﬂJ 852 C L!ﬁ'JSlWLfJLl@’Ja\TQﬂ?ﬂi?ﬂ!i?ﬁ]?ﬂu1«!1!11‘]J3Lﬂ51$ﬁ
a < o 1
ArenAiin X-ray diffraction (XRD) Wueyna TiB, uag TiAl, Usinglimuinuaasiniinig

a

malfnsemennudounaziiaoynia TiB, uag TiAl, Ngangil 852 °C uaziiioiuguugi

U

2 o ~ o A v o A a 0 [ A
AU 1,100 C aYMANNUINAURNDUNUNUNGUHYN 852 C N3 DTA Llﬁﬂiﬂigﬂ‘ﬂ 2.17
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852
TI
)
&
= 636
]
<8
T 1008
l
660
0 200 400 600 800 1000 1200
T(C)

s 2.17 HANATIZHAOINATA DTA U949 lanenaunian Al-Ti-B dadu

Tuezqiiiioy s0%Tavtimin [22]

MsIAuNGe KBF, uazinae K,TiF, avluezglifiouvaouanionanoynin TiAl, uaz TiB,

Y Y
= Y

H 4
luTavgwaunan ALTI-B [23] Ufnseriinaduriusg ldneynia TiAl, oynia TiB, uaz

Wand KF-AIF, TuszunTaouaaaiuaumsmandifdadu iy
(KBF,)) + Al,, = (KAIF,) +B 2.21)
3(K,TiF) + 4Al, = 3(KAIF,) + 3(K,AIF,) + 3Ti (2.22)

a Aaan [ a a I
amammﬁmim’au !La”llﬂﬂ"llﬁﬂﬂ ‘ﬂ“’!ﬂﬂﬂQﬂiﬂ?ﬂﬂ@”@@ﬂ‘u@ﬁﬂ“’aﬂLﬁﬂﬂlﬂﬂlﬂu@uﬂ'lﬂ

TiAl, uag TiB, UuWHIﬂiﬂﬁiNﬂl@ﬁ’ﬂ a‘JJLLlfJiJ ﬁ’JuV‘IaﬂGI)'KFAlF mwn%uaamamau

~

3
a A v
pzQIlENAag1N 2.18

After Al metal melting

After adding flux

(a)

After flux-metal
reaction

FLUX

v

(c)

51/ 2.18 Wdndvounde Hdeuseudoussgiidion [23]
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a Aaaa 1 & J
luszuvvesmsinalisessuiaunaovesans Inunadon lnm Tugooisa (K,TiF,) Fuily
1 I 1
unasli g Innuilen (Ti) nazinde TnunaFeurlges Isueisa (KBF,) iflunnaslisig Tusou
Aa A a A a A A o 9
(B) luezgiiisuvasumal MsANNa0v0d KBF, adlueygiitisnviasumanierinlv
a aaa 42‘ 1 Aa A a I ]
nalfnsevussninesqition (Al uazluseu (B) lasnatluasisznouves AIB, au
4 o Aaaa [ a a I @ 4
Twunendon (K) vazvgoeelsd (F) slgnsenuezgiiiion (Al madluasszneudnd
v 1 Y
KAIF, gaaumsiaasignseonniii 2.23 3amsinaeymavediseynin TiAl, iag TiB, Tuszu
Y
YoIMIIANINGD KBF, uazinde K,TiF, Tuezgiilsnriaoumvaniuainmsinaljnseuniae
{ o aaa [ a a [ L4 {
KBF, Winlgnseduezgiiisunasumiad inandnd KF-AIF, uazezaonvedlusaunuen
a Aaaa ] a A a I Y] ~ ] A
panu1 Tuseuszinalnsenuezgition inaluaislsenen AIB, Asaumsi 2.24 aIunae

U

o aan @ a a [ 4 ~
K,TiF, $11A5e1 10 ezgiitiourasumannaand KF-AIF, uazozaousig Innuileuiuen

U

a aaan o a a [ 1 : v
ponuuAalfnsenvezgiitieuAaillueynia TiAL, druounInAlB, Favg luadesluszuy

o aaa Y . a g .
V99 Al-Ti-B 9z a 113031113 ennueyna TiAl, nailueynia TiB,

2KBF, + 6Al <> 4AIB, + 2KAIF, (2.23)
3K,TiF, + 13Al < 3ALTi + 3KAIF, + K,AIF, (2.24)
ALTi+ AIB, < TiB, + 4Al (2.25)

a aaa ' a A Y A a ~ £ g
Manalnienszring ezgiibeniuluseungumgilssina 659.7 esrusareadauiluns

U

a aan a A a S <3 4 £ a Aaaa dy I
allfnsegmaaalasilsnalusen 055 nlesiiudezaey  Famsinalnseriazily

=

Aaaa Y A a dg‘ I £
U N3819ANNUITOY (Endothermic reaction) [24] uazeynannavuilueynin AlB, #9zil

= =

Y )
dosn e luszunves Al AU B miniu [24] uaziileiimsdunasves K, TiF, asluild

A

4
inalgnsenudulasnaazateveanaslag K, TiF, Mignsenuezgiitisnviasuima (Al)

a A

@ @ a J [
Ulﬂ‘ﬂ’llﬁﬁlll%%!&flﬂﬁ']@@ﬂ3J1'i'JiJﬂ°]J@$ Mluﬂﬂllaﬁlﬂﬂ!ﬂuﬁ'ﬁﬂigﬂﬂﬂ TiAl, @7U TWLW]@TL%EJ?J

U

a A

J v o a @
(K) nazigoo l3a (F) vzsudinivezgitisundunaaissznon KAIF, uaz K,AIF, A3dums
voulnTenalin 2.23-225 vwauazmMInszeaIveteymainavuiuiaverdanlums
AAUAL MuvIMINalnTeny gungiveamanalgnse na lumsinal§nser vay
MImMunaNszuy Tudrmumsi@uinasfuana9nunuIMsaunae KBF, asluezqiition
v 9

vaouiadnouvz lalsma lnnuilenigeaniimsiaunie K,TiF, asnoumsnauinaoniaes
Y 9 1Y 1 a Y Aa 3 = d‘ 1 a A A

Whanenunewauas I luszuvag IduUSunaia lnnuiioy naz Tuseunmnnimsiauiiazinde

v 4 v 4
av ) narlumsimalasoninuaui v dusunasig Innulisumiuuniu daumsniuwdy
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Y ~ o o q I Y (a ~ U o A
GL‘LJ?JZ‘IJ“IJ@’JEJ!GHW@@‘JJLL’U’ULWHEJ’J“LH“V]ﬂ‘Hhlﬂﬂilﬂmhl‘l/ﬂ/ﬂmﬂhﬁﬂﬁﬂ [26] ‘]Ji]i]ﬂTlﬂ’J‘lJﬂilﬂJuWﬂﬂl@ﬂ

. = ' A a ~ Y a = d?
pUNIA TiAl BnednAolTIavessn Innuilenluszuud Usma Innudfiounniuvnaue s

v 4 4
aUMAIZIANIY uonvntidadiuvesua Innution vl Tusou dslinasominszate

v A a 4? A o a ~ 1 a < £ 1 A
@13611@qmgﬂmmﬂﬂmuwﬁﬂmummﬂsmm"lwmmﬁlmaﬂimmimamﬂuwumaﬁu N3

@ @ IS 09/1 {
nsznedveseymnvziianyavilufuveseynia TiB, fAdeusoueynin AIB, 13nelu

1 1 A 4
39317 2.21 nazvuiaveseyninzivinaiiuana uiuiuuegiumsunsvesoymaluszuy

u

4
MMINOYNMIATTILIUNINTZEZVDIMTUNT TUVUIAVBIO YNNIz TVIIA TH [27]

] o 4 - - ¥ -
&

4
a =

' 1
1 =

dszansamlumsdsvanunsuliaziBoavesoynia TiAL NlzUseiuana1iu densiie

U
9

A o Y = A Qy 9 = 1 1 [
madonamulumsdsvanmnsulidaziBeaonanar Iumdu szvieglsiwmumdy
{ g 4 3 & ] L
(Needle-like) 111111 a8N (Blocky) HagtUUHauNamasuuaziun (Mixed) Wunwungiuuoidlu
a a A Y A | A A A A A
JUNIundsN (Blocky) amsd@enanimilosiga uazzilsininamsidonannuiniga fe
I A = ~ [ . Y
uUAN [28]  vinaveseymaniviandeuntadlidanmsialavenaunan AITi-B - 14
@ I 3 1 A a a 19
symauaninuazlvaananiu awnsogromulszaninmlumsiSuanmnsuliaziden
[ A dgl 9 A g a a = 9 1
yos Tavzwauvanimuiu1d 29] vinaveseymaidnizawnsanalunded lauInnI1eynIa
Aa A 1 A A A 1 o o I ¥ A = ' o = '
e lugiiodrunavvessigidsmaiminuild Idinsuiazideanin uuaaIdimiu
s aazvuIAveIoYNIA TiAL Las TiB, lulavswaunaninadanuaisalumslsy
Y = a A = [ A . v o
amwnsulvazidealuergiiion tazlumswion lanswauranainnae K,TiF, n1 KBF, M
Ugnsernvezqiifieunaouralrlasindinunisiaunae Iduanaeiunazinarlunis

Y 4
alfnsemanantuiudwalivuiasazgls weeseynialulanenaunaniuuanaieny
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Y
udIdIAUMIIAN K, TiF, iU KBF, asluezglifisunaoumad uaznar lumsimadfnseniuogd
Haod1e lsnovuIagls wveseyna uazazdiwand e lsasilszaniamlumssuanminsu

Itazivoaluszgiiiionvae
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Y 1 =

Y ]
msauduutazdsmsduiuaudteluunilanandimsessunazms 150uidg nseeilo

o a =

¢ Ao I 9 Y Ao § 9 1 A a A
wazginsal N3 duasaldlumsdiiuannide $alseneuatsunidunesnvetnsgiiilon

4
a a

UsgNBnTagadImnIsy Manindesldlunmsmion Tangnaunan wvasn lWihriavaaie
1T ' 4 ay 4
Aunu ga laund lalasiou nuunas (Mold) gUnssinsim3susuaiuieg Iaseass uaz
A A A Eal Ao = oa/’

159U AATILHAN ) NIWulumsnaden aaparumswIsutuneuMsiaoNazatslany
v A o v A =S 9 a A Y]

NMIATIVIAIATIZH lanzwaunaniesou1a naznisnadevlszdnsamlumsisuanin

Y = a A 9 v A =~ 9 o a a v

insulazidoavesezgiifiouarolanenaunanimsonld  msduiuauideTasnins
1 o a av J qazl o @ J qa.: Y

aunsouanmsduiunuITedlu 3 Tuasundn 9 dail Ae Tuaeumswion lansNauan

3 a o v A =~ 9y 0311 Aa A

TUADUMIINTIZH Tanznaunaniaionla uazduaeumsnaaevlszansninves Tansweaw

wanlumsisvanmnsuluezqitionnas aweaaalugiin 3.1

G %
!ﬂ‘iﬂ&liﬂ?‘i%ﬂﬁﬂﬁﬂﬂ

v

Innzilanznannan
den3esile
Optical Microscope (OM)
Scanning Eletron Microscope(SEM)
X-ray Diffraction (XRD)

Spark Emission Spectrometer

!

nagavlszansmnlanznannan

] Y
519 3.1 LEUAITUABUMTA UL UIUIDY

UG
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Y 4' A d
3.1 Jaquazinsesiegilnsal

3.1.1 Tagldlumsinsenlavizwanyian

1.

10.

1 a - { a o 1 = a Q(
unsduneaigqildlumsnaasnazide  ldunTanzwauezgliionnigniinaa
1 A A a L4 4 [
gaenssuldrunaumuainlannnsinsizialeinToe Emission  Spectrometer A4

uanalua131en 3.1

v 4
M3199 3.1 daunaumunived langezgiiisnnasinsauIgns (wi%)

NN Si Fe Cu Mn Ni Zn Ti Pb Al

ﬂ%mm(wt%) 0.030 | 0.098 | 0.001 | 0.002 | 0.004 | 0.100 | 0.005 | 0.006 | Bal.

= ~ J J . . . . g
mﬂwgmmcﬁﬂu 1%%1&1!8%!3?1?’{31/1@@65“15@ (Potassium Titanium Hexafluoride) an¥e
[ =2 o = Y . |
WURIHanav1 Ugasaliilu K, TiF, ¥inemy CAS NO.240-969-9 1ia Tuanarilu 240.04
Hazliganasuial 780 °C

~ J . Y < =
ﬁ?iiWLLﬂﬁL%ﬂMlﬂiﬂizWQﬂﬂiIi‘umi@ (Potassium Tetrafluoroborate) anyaItuNINan
= = A I =
guniligasaiiiilu KBF, %1181y CAS NO.237-928-2 13a luanaiilu 125.89 uaziiya
Waauval 530 °C

a { o I { o [

vy Iihaidamiiei (Induction Furnace) 1WhuennlddmsumsmsviasyTan

a I { ) o o
o T fhyiinvaaind1uniu (Blectric Resistance Furnace) 15 lgdmsunsnndig
Y a A o [ 1 9 [ a dy ~
Tangnaommnalrlgurgiaan uazdmsumsguiuazuuuvas lagmsiaiogl

a v £ ! ] Y} Aa o Y A & v a

yaadasian umusuunrasldnnuion tognuldimihnduauiunnuiouyda

% =3 a

A A o 3 ~ Y Y I a o A 9 J ™
ﬂ'UL‘]Jﬁ@ﬂmTﬂ‘ﬂﬁnﬂ!fHﬁﬂL'I’TLlEI’J @1m‘wunﬂuvhﬂmﬂwumaawu‘lﬂauauumuﬂmm

E] 9 E]

[

a 9 1 Y 1 { o @
ﬁﬂﬂﬂlﬂﬁﬁ)ﬂ ﬂ’311]’5Eluiﬂﬂ"llﬂa’mi]$iﬂEJ!‘V]L"UKITETH8Wﬁ@hLWﬁﬂﬂ1ﬂiuLﬁﬂiﬂH1‘iZﬂﬂ

4 =

a Y ~ {
QmwgmmTamwa@umaﬂwmw ﬂ\ﬁﬂ‘ﬂ 3.2

u

ihviaeuTarewsila Silicon Carbide
o s A T w ¥ o o
undorsnowive laund laTasnu wiouszuumiuguANNAULAZ RTINS 11a
! { o J . (% {
uuuaeN i m191nn51 1WA (Graphite Mold) A931/91 3.3
AT Digital

[

nsoiagunnl

q U
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@a0 mim.

@40 mm.

40 mrm.

51 3.3 nuunaenat lwiginsanszuen

U

LY A A ¢ A Y
3.1.2 Taquazinseaneginsal n¥lumsnaaeumsdsvanmmnsuliazioen

1.
2.

4
a a

HDUNDADLUINBNTGNT (Pure Aluminium Ingot)
whviaeu Tane¥iia Silicon Carbide
wvaon Iihaiiamiiensin (Induction Furnace)
[ o
Wan% (Cover Flux)
T Ao 3 Y Y a am
uuunasniMNmannd ¥ adunuasuIaggIu TP-1

IATO9FIUV Digital
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517 3.4 wnvaon IWihnlFlumsnaasssiauaatamtieniwig 12 Aladaa

UG

da ¢
3.1.3 Qﬂﬂimm‘ﬂuﬂ1iﬂﬂﬁ®ﬁ!m$ﬂ1‘§3lﬂ‘§1$ﬂﬂﬂﬁﬂﬂ

1. IA3edANIEAHNT U EIONIY

2. m?'mﬁffﬂG‘ﬁ‘ymmmﬁammumuwuu l¥ianszauneuaznaia

3. ndesansseniuuy1Fiies (Optical Microscope) ¥84U3HN Olympus T4 GX 51

4 inseanadeunnlSuaid unaumunil Spark Emission Spectrometer Y94U31N Baird U
Spectrovac 2000

5. ndesaunuiladidansoululasalall Scannig Electron Microscope (SEM) ¥04U31N JEOL
34 JSM 5800

6.  Energy Dispersive Scatering (EDS) Y041/3H" Oxford ij:u ISIS 300

7.  X-ray Diffraction (XRD) V9IUTHN Bruker AXS :g'u Bruker D8 Advance

3.14 manfiidmiviansaglassadiuazvinansy
1. nsalalasmnasin (HCI)

2. nialuain (HNO,)

3. ninalalasgensn (HF)

4. upane@od

9 v
5. dnau
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3.2 mamsenlanzNanyan Al-5Ti-1B

3.2.1 ¥a¥miin Al K, TiF, 1as KBF,

v '
lusasidrunay AL-5Ti-1B Taomsmiuiaiminuessig dadiuluavessiaidesns

A9 NIANUIN N

[

K,TiF, 1 [ KBF, } [ Al Ingot ]

L'

L

FavInana I FIhminaaa I
Al-5Ti-1B Al-5Ti-1B
[ 21 350 °C ] [ viaod 800 "C ]
> NaNITIUDY < 1. 1A} KBF, Nou
40 XXX A v
, 2. 10 K, TiF, nou
1.1 min
3. HEIANNSONNY
2. 30 min
d
_ uuuriaens1 Ina
3. 60 min

9

311 3.5 U UTUAOUNINAABINITIAToN TanENANHANMNAIAUNTANAITRUANA AU

3.2.2 MItaseulansNanian

1.

ouezaiiionlaasludihvasyTanzwila Silicon Carbide 11a211 11 msvasuman

u ]
aamviaon I hguvgd 800 °C

a

9/ e . P o =S A [ v A a d?
auttvaonlavie Silicon Carbide NYUNYU 800 C anluesessundnsninauu

U

o N . v 9 a A J Y o
UINUBUNAaD K, TiF, tas KBF, ﬂem&azgmuﬂNWaﬂa LLaauﬂﬂﬂuﬁlmm@mmmmmﬂ

a =

] Y v
Aumuive lannudugaumngil 350 eerumaFeod w1 30 Wi

QU

a a 1 o 1 [

mmﬂﬁa KBF, aﬂuasgmﬁﬂnﬁaamwmﬂau LL’S’J‘VHﬂ"Iiﬂ’JuiﬁJ‘UTﬂﬂﬂﬁW‘uLlﬂﬂ’
J A o [+ a 1 ~ a =

miﬂ’auaﬂﬂwammwﬂwammuﬂﬁ 5AATADUIN UIU 10 IUIMN

Aa A . 9 ' [ 4 a = S o Y
wmunae K,TiF, avllluszuumuszuuaremsnuunaeIsnouuIY 10 Afinndurind

a

3 Y A 0 =}
@]Qi?iﬂl@TﬁﬁﬂNﬂQﬂ!ﬁﬂN 800 CUIU 1 UM

G
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[ S A Aaaa = qa;l [} a Aa A 1 9 ~
6. mildnsninaanlsodaenduasseguuiiveesgitionraoumadldasluim
= 2
w3 o'
] (7] J 1 Aa A 9 o g’ =
7. wuunaersnoulalslasiauluezgiitionvaouvar ndrimisimitozgiiiion
1 d' o 14 . d‘ a [
naoualad luuUUas N NN 11N (Graphite Mold) Ngauvgun 720 C
@ P @ v A o 09: { a
8. mandnuen Bndudunluszuuduaundnindias B luamasuigungil 800 °C wu
30 1AL 60 UINADUNIMTNA IULDLHABUADETOUMNTHE lansHaNran Ing AI0NHI
M8 SMUMIIANNOU B = KBF, Ti = K, TiF, 1142 M = Pre-mixed @74 A10UN10D

[

nanlumsinelnen 1= 1111 30=30 w9 uaz 60 = 60 1N AN 3.5
o Y Y = A o w a A g a . '
9. MMInaassnalete 1 949 8 uanasudmaumaaunastiy iy K, TiF, oy
0 Yy = v o v a g A o Y ¥ o Y o
10. smInaaenalete 1 948 uanlasuddumuiunaunaeniaouTINILAY 1AINT

wuadluTangraoumaindounu

M99 3.2 YSunaasnld Srvumaauneutaznainaa laverasumiad

sHalan Sanee () . o namMsmalane
. SiumsANneu .
WaENYian Al K,TiF, KBF, Hasutia(HIN)
B-1 1
B-30 389.77 108.57 50.43 KBF, 30
B-60 60
Ti-1 1
Ti-30 407.78 113.59 52.76 K,TiF, 30
Ti-60 60
M-1 1
M-30 383.20 106.74 49.58 w%’auﬁ’u 30
M-60 60

*NOINE ONHIAINTI NG SIAUMSIANNDY B = KBF, Ti=K,TiF, 11a2 M = Pre-mixed

2 = a aan =) ~ =)
AU UUIYDN Lﬁlﬁﬂuﬂﬁlﬂﬂﬂgﬂﬁm 1 =141 30=30 U iag 60 = 60 UIN
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qw 4 A J
3.23 ﬂ]i!ﬂ%ﬂN‘UHﬂﬂﬂﬁ‘l.l!ﬁ@'Jlﬂi]%‘l’iiﬂ‘iﬁﬁ%,1x‘lﬁﬁﬂ1ﬂ

1.
2.

o

o A Y o A =) a 1 Aa a
uﬂamNﬁwaﬂm"lﬂ"lﬂ@mmwuamﬂmmq 10 Wanluag

o ng @ 4 . 4 v A Qy @
MFUNAFeUTARIENTEATHAWIIUILDS 40 grit USRI Funaaeu ¥iSouudva
Y

AENITAENTIB1 U3 180, 320, 600, 800, 1,000 L% 1,200 grit MUSINL

A4

VAAZIDIARIINUNTI NHANNUAITHADAY (Diamond Lubricant) ¥11A 6 1ag 1 lunisu
auduuuidnvala

Y 1
wnnamhdemsazatenay nialalasgedn 0.5 % Taelsuas luhnau

Yo v o s o w Y9 v Y 9
AANuEz 1A 2011 Laztwanagaamua1ay uanthateausouliuig

E4
o A

¥ v v @
uﬂﬂ!‘ﬂ@af]ﬂllﬂ@i’nﬂiﬂ‘i\‘lﬁi%‘]ﬂ'ﬁﬂ1ﬂﬂ38ﬂﬁ@ﬂﬂaﬂiiﬁullﬂﬂllﬁ\1

e <

o Y Y Y a a
‘L!1“]5‘Ll1/lﬂ’df]‘]Jll‘]J¢]§’Ji]@jﬂ‘i\?ﬁ‘ﬂ\‘iic].ﬁﬂ1ﬂﬂ’38ﬂﬁﬂ\1ﬁllﬂuu\‘lmﬁﬂﬁiE]‘lellljﬂiﬁiﬂﬂ ag
a I Y a . . . 4 a L4 . '
AUATICHAIUUNAUA Energy dispersive scatering (EDS) WO UATIZN X-ray mapping U9INQU
2UNA

0 A a 7Y A
u'lclfuq']uhlﬂglﬂﬁ’lgﬂﬂjﬂlﬂiaq XRD

a d
3.24 ﬂTi’J!ﬂ'i1$Tiﬂ1‘iﬂ’i$%1ﬂellu1ﬂ°ll@Q@Hﬂ1ﬂﬁ?ﬂiﬂ’i!!ﬂ§3~l Image J

1.
2.

i luTasnsl lddsuuasanuangavesoymadieTusunsulsuuaanin
AannTysunsy Image J tazdsvmevainaves IsunsunuanavednIwi Analyze >
Set Scal lamamnavean I

o 3
15 Image > Adjust -> Threshold.. 1111 0-50
1@en Analyze -> Analyze Particle..

A Y : : e y_ A . v A o .
ONHUIN N Particle Size Distibution t42tad N List %zllmumwummaumﬂ (Size Area)
HAZTIUIUVDIBYMANTYUIAA ] T1UIU n BYNIA

Yo A A 4 ' v o A
Triduls A, ABVUIAYEINUNVBINGNOUNIA (Size Area) RAUNUTIUIUVDIDYNIANVUIA

A4 9 (n) a1 A, = Size Areax n, e i=194n

Y 1
=) ~

= ~ Y dil A A 1 [ 09:
nJifmmsmﬁaaazmmwummmaumﬂwmumma I NUNUNVIIDYUNTIANINUA
_ A x100
~T

Z‘A

v o J 1 { A @ { A
Wounsugasnnuduiuisznieiosazuesiunveseynin (B) NuvMIANUNvT

B
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3.2.5 MSIASENTUNATDUINONANININAN (Deep Etching)

E
o A v 9

4 4 v A Qy
1. 1BuUNadoUYARNTTAHEENIUILBS 40 grit tiolSuimThFunagenlnisey
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TABLE 4 Grain Size Relations Computed for Uniform Randomly Oriented Equiaxed Grain
ASTM ASTM Diameter of Average Average Intercept | ppiercept | Area of Average Grain per Area
Macro Micro Grain Grain Section Distance’ Count N Grain section of Ix
Grain Size Size 5 B
Number Number G Nominal d_ First in o T in I . N, . mm n .in
MG mm in d mm . . 100 mm . . x10”
M-0 36 1.4 40.3 32.00 1.26 3.125 1290 2.00 0.775 0.50
M-0.5 30 1.2 33.9 26.91 1.06 3.716 912 1.41 1.10 0.71
M-1 25 1.0 28.5 22.63 0.891 4419 645 1.00 1.55 1.00
M-1.5 21 0.84 24.0 19.03 0.749 5.256 456 0.707 2.19 1.41
M-2 18 0.71 20.1 16.00 0.630 6.25 323 0.500 3.10 2.00
M-2.5 15 0.59 17.0 13.45 0.530 7.43 228 0.354 4.39 2.83
M-3 13 0.50 14.3 11.31 0.445 8.84 161 0.250 6.20 4.00
M-3.5 11 0.42 12.0 9.51 0.375 10.51 114 0.177 8.77 5.66
M-4 9 0.35 10.1 8.000 0.315 12.5 80.6 0.125 12.40 8.00
M-4.5 7.5 0.30 8.5 6.727 0.262 14.9 57.0 0.088 17.53 11.31
M-5 6.5 0.25 7.1 5.657 0.223 17.7 40.3 0.063 24.80 16.00
M5.50 5.5 0.21 6.0 4.757 0.187 21.0 28.5 0.044 35.08 22.63
M-6 4.5 0.18 5.0 4.000 0157 25.0 20.2 0.031 49.60 32.00
M-6.5 4 0.15 42 3.364 0.132 29.7 14.3 0.022 70.14 45.25
M-7 3.2 0.125 3.6 2.828 0.111 354 10.1 0.0156 99.20 64.00
M-7.5 2.7 | o.105 3.0 2378 | 0.094 42.0 72 0.0110 140.3 90.51
in.x10” in.x10” in.x 10’
M-8 22 88 2.5 2.000 78.7 50.0 5.04 7.81 198.4 128.0
M-8.5 1.9 74 2.1 1.682 66.2 59.5 3.56 5.52 280.6 181.0
M-9 1.6 63 1.8 1.414 55.7 70.7 2.52 391 396.8 256.0
M-9.5 1.3 53 1.5 1.189 46.8 84.1 1.78 2.76 561.1 362.0
M-10 1.1 44 1.26 1.000 33.4 100.0 1.26 1.95 793.6 512
M-10.5 0.95 37 1.06 0.841 33.1 112.2 0.891 1.38 1122 724
M-11 0.80 31 0.89 0.707 27.8 141.4 0.630 0.976 1587 1024
M-11.5 0.67 26 0.75 0.595 234 168.2 0.446 0.690 2244 1448
M-12 0.56 22 0.63 0.500 19.7 200.0 0.315 0.488 3174 2048
M-12.3 00 0.51 20 0.57 0.453 17.8 221.0 0.58 0.400 3875 2500
M-12.5 0.47 18.6 0.53 0.420 16.6 237.8 0.223 0.345 4489 2896
M-13 0.40 15.6 0.45 0.354 13.9 182.8 0.158 0.244 6349 4096
M-13.3 00 0.36 14.1 0.40 0.320 12.6 3125 0.129 0.200 7750 5000
M-13.5 0.33 13.1 0.37 0.297 11.7 315.05 0.111 0.172 8979 5793
M-13.8 0.5 0.30 11.9 0.34 0.269 10.6 317.6 0.0912 0.141 10960 7071
M-14 0.28 11.0 0.32 0.250 9.84 400.0 0.0788 0.122 12698 8192
M-14.3 1.0 0.25 10.0 0.28 0.226 8.91 442 0.0645 0.100 15500 10000
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